fa\ DataRay Inc. Application Note

OCX Software Version 5.xx Installation

Applies to:

O

]

O

O

O

BeamMap, BeamMap-C, BeamMap ColliMate, Beam’R, BeamScope-P7

WinCamD & TaperCambD series

The current Version 5.xx of the iDataRayOcx.exe software

Windows 98, 98SE, Me, 2000, XP Home and XP Pro; Windows NT with limitations - see below.

Systems with iDataRayOcx.exe software versions older than 5.00A1 showing a No card found or other
card problem.

Fixes: Uses a completely new DataRay-authored PnP driver to fix installation difficulties seen with Notebook
PCs using Magma CBI1H, and the few desktop PCs that have given problems. All new software releases will
be based on this OCX software.

You need to know that:

a)
b)

c)

d)

This new driver is a fully compliant PnP (Plug and Play) driver.

Windows does not know which driver to use until it has been told so by the DataRay.inf file.
The Windows Found new hardware Wizard process introduces Windows to this file.

For Windows NT, 2000 and XP Pro, you must install as Administrator, or you will fail. (‘... with
Administrator rights’ is not adequate.)

This software does not work for WinCamD with Windows NT, and requires a specific installation
approach for other instruments. Installation for Windows NT is different to that for other Windows
Operating Systems. It will not use the new PnP driver. Go straight to Section F.

If you are currently working with NT, we recommend that you upgrade to XP Pro. XP Pro in particular is
a stable operating system and reboots quickly. [The big advantage of Windows NT was in corporate PC
networking security. Other than that it was a ‘dead-end’ operating system. It is not ‘Plug and Play’
compatible. Despite what you may have been led to believe, Windows 2000 & XP are actually
Windows98/Me descendents, with the NT network security functions bolted on.]

When the PC boots up, if Windows finds a new (not there last time) PCI card, it will look for a driver.

If a driver has already been installed for the card or card family that Windows has found, and this driver
has previously been used in connection with the installed card or card family, then Windows may
automatically install the card.

If Windows does not have an installed driver that it has previously used in connection with the installed
card or card family, it will start the Found new hardware Wizard.
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f) You should check and as necessary change the Windows Exploer default settings, or you may not be able
to find DataRay.inf in Windows Explorer

In Windows Explorer, from the View pull-down menu select Details.

From the Tools menu select Folder Options. Choose the View tab and change the highlighted items to
the settings shown.

General Wiew | File T_I,Ipesl Offlire: Filesl

Falder views
'ou can apply the view [zuch az Detailz or Tiles] that

i woul are uzing for thizs folder o all folders.
a8

Bezet All Folders |

Advanced zettings:

O Dizplay the contents of spstem folders ;I
[ Dizplay the full path in the address bar

{3 Do not show hidden files and folders
(%} Show hidden files and folders

[ | Launch folder windows in a separate process
I3 Managing pairs of Web pages and folders
(%} Show and manage the pair az a single file ;I

Restore Defaults |

k. Cancel | Spply |
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INSTALLATION INSTRUCTIONS

If an installation is unsuccessful, even after re-reading the instructions, contact DataRay support.

A. ‘New’ PC system - one that has never previously seen the DataRay software.

(For a new installation in a Notebook PC systems with the Magma CBIH interface see the Application Note at the
website.)

1)

2)

3)

B.

Install the iDataRayOcx.exe software BEFORE installing the PCI card.
From a CD: Go Start, Run, Browse to d:\iDataRayOcx.exe, [d is the CD drive letter], click OK.

For a downloaded version: In Windows Explorer, locate and double-click iDataRayOcx.exe.

Follow the installation procedure. Start the software by double-clicking on the icon. This loads the
DataRay.inf file. Close the software.

Turn-off the PC, disconnect the power cord.

Install the PCI card using static-safe procedures. Reconnect the power cord and restart the PC.
The New hardware found Wizard will appear. Click Next to let the Wizard follow its default choices.

As necessary Browse to find the DataRay.inf that the wizard seeks in c:\Program files\DataRay or the
c:\Windows\Inf or c:\WinNT\Inf directory (Windows version dependent).

The Wizard should find and load the DataRay.sys file automatically, but if it does not, Browse to find it
in the c:\\Windows\System 32\Drivers or c:\WinNT\ System 32\Drivers directory.

Start the software. In the pull-down menu, in Device, select the instrument that you have installed.

WinCamD, TaperCamD series Press Go. |igi F

All others. Press F for find to initiate finding the beam. &

‘Clean’ PC system - The DataRay card has been working just fine, but you wish to perform a

complete software upgrade to Version 5.00A1 or higher. Go to 4) below.

C. ‘Bad’ PC system - Has the DataRay software & card installed, but the PCI card is not detected &/or
the software does not appear to work.

4)

5)

6)

Rename the old directory. For safety’s sake rename the current DataRay file to its version number. E.g.
if version 3.00H2 is currently on the PC (see the blue top line on the software display), close the software
and rename the c:\Program Files\DataRay directory to c:\Program Files\DataRay300H2.

Reading data files taken on earlier software versions. DataRay tries to ensure that all new releases are
backwards compatible in terms of reading files taken with earlier versions. If you wish to actually run the
instrument on the older software version, see Section G, below.

a). In Windows Explorer, locate the c:\Windows\Inf or c:\WinNT\Inf directory (Windows version
dependent). Perform a Search for all Files containing the text DataRay. This will include *.inf and *.pnf
files, some with names starting DataRay, possibly some with names starting oem. Select and Delete
them all.

OCX Software Installation 30of 10



7)

8)

b). IMPORTANT — WinCamD only. If you still want to occasionally run an older version of the old
software, 3.XX or 4.XX, do not perform step b) Go straight to ¢). However, item E. on page 7 will
annoy you on reboot.

In Windows Explorer, locate the c:\Windows\System32\drivers or c:\WinNT\System32\drivers
directory (Windows version dependent). Locate and Delete both windrvr.sys and winpnp.sys, and,
if present, DataRay.sys and/or windrvr.vxd.

¢) Shut-down and then Restart the PC.

Install the iDataRayOcx.exe software.
From a CD: Go Start, Run, Browse to d:\iDataRayOcx.exe, (d is the CD drive letter), click OK.

For a downloaded version.: In Windows Explorer, locate and double-click iDataRayOcx.exe.

Follow the installation procedure. Start the software by double-clicking on the icon. This loads the
DataRay.inf file. Close the software.

Uninatal” the curant card. Righ

click on the My computer icon, and
click on Properties.  Click on the
Hardware tab and click on Device |4 = [ | 'S (@ & = 3 &
Manager. (Varies between Windows
versions. Not present in NT).

File  Action  Wew Help

=1, LUDACRIS_SPEED
- i Computer

The card will appear as a DataRay - E@ DataRay
BeamMap series or a DataRay - BB DataRay BeamMap series
WinCambD series. O - M [1ataRay WinCamD series
) . »qp Disk drives Update Criver...
Locate and right-click on the - @ Display adapters Disable
DataRay card, select Uninstall. - h DVDJCD-ROM drives Uninstal
! AIS(? unin.stall any Unkno‘.Nn @ :Dppy jfstzu.ntrnllers Scan fFor hardware changes
Device with an exclamation & Floppy disk drives
mark against it. 2 PG AL Properties
-2 Keyboards

Then, from the pull-down menu,
select Scan for hardware changes. The New hardware found Wizard will appear. Click Next to let the
Wizard follow its default choices.

As necessary Browse to find the DataRay.inf file that the wizard seeks in c:\Program files\DataRay or
the c:\Windows\Inf or c:\WinNT\Inf directory (Windows version dependent).

The Wizard should find and load the DataRay.sys file automatically, but if it does not, Browse to find it
in the c:\Windows\System 32\Drivers or c:\WinNT\ System 32\Drivers directory.

Shut-down and then Restart the PC. Perform 3), above.

D. Problems I - ‘I did all this and it does not work.’

9)

The most likely cause is that the old driver is still hiding in the system and is being detected and installed.
Right-click on the My computer icon, and click on Properties. Click on the Hardware tab and click
on Device Manager. (Varies between Windows versions. Not present in NT).
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If the card appears as a DataRay BeamMap series or a
DataRay WinCambD series, then it is still using the older
driver.

EI@ DataR.ay
- HB DataRay BeamMap series
i EE DataRay WinCamD series

Hardware Update Wizard

Welcome to the Hardware Update
% Wizard
Thiz wizard helps you install software faor:

Beamtap / Beam'R / Beambap-C and BeamScopeP?

Prafilers

Z;:'f\,l If your hardware came with an installation CD
-~ or Hoppy disk. inzert it now.

What do ol want the wizard bo do?

™ Install the zoftware automatically [Fecommended)

% Install from a list or specific location [Advanced]

Click Mest to continue.

< Black I Mest » I Cancel

Right-click on the DataRay card and select Update Driver... .The Hardware Update Driver will appear.

The examples shown below are from Windows XP Professional. Other Windows versions will have
minor differences in wording.

Select Install from a list or a specific location (Advanced) and click Next >.

Select Don’t search, | will choose the driver to install and click Next >.

Hardware Update Wizard

Please choose your search and installation options.

" Search for the best diiver in these locations.

Ilze the check boxes below ta limit or expand the default zearch, which includes local
pathz and removable media. The best driver found will be installed.

[T | Searchremovable media [floppy, CO-ROM...]

¥ | [helude thiz lozation in the search:

IE:'\WINDDWSHSYSTEMEE'\DHNEHS j Browse |

is Don't search, | will choose the driver bo install:

Chooze this option o select the device driver from a list. Windows does not guarantee that
the driver you chooze will be the best match for pour hardware.

OCX Software Ins < Back I Meut > I Cancel




For WinCamD you will see the following screen. Choose DataRay WinCamD Camera and click Next >.

Hardware Update Wizard

Select the device driver you want to inztall for this hardware.

Select the manufacturer and model of your hardware device and then click MNest. [F pou
hawve a disk that containg the driver you want to install, click Hawve Dizk.

¥ Show compatible hardware

Madel |
[ atal ay ‘winCamD Camera
Dratal ay WwWinCamD zeries

Thiz driver iz not digitally zigned! Hawve Dizk. .. |
Tell me why driver sighing is irmparkank

¢ Back I Mest = I Cancel |

For BeamMap, BeamMap-C, Beam’R, BeamScope-P7 and ColliMate you will see the following screen.
Choose BeamMap / Beam’R / BeamMap-C and BeamScopeP7 Profilers and click Next >.

Hardware Update Wizard

Select the device driver you want to install For this hardware.

Select the manufacturer and madel of pour hardware device and then click Mest IF you
have a dizk that contains the driver pou want ko install, click Have Dizk.

¥ Show compatible hardware

Madel |
Beamtdap / Beam'F ¢ Eeambdap-C and BeamScopePy Profilers
DataFay Beambd ap zeries

Thiz driver is not digitally signed! Hawe Disk... |
Tel me why diver zigning iz imporkant

¢ Back I Hest = I Carnicel |
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The Wizard should find and load the DataRay.sys file automatically, but if it does not, Browse to find
it in the c:\Windows\System 32\Drivers or c:\WinNT\ System 32\Drivers directory.

x
- Thefile 'DataRay. sz’ an [Unknown] iz needed. 0k |
s ’J

Cancel

Type the path where the file iz located, and then click
OE.

Copy files from;

II::HWINDEIWSHSYSTEMSE'\DHNEHS j

The screen below will appear. Click Finish.

Hardware Update Wizard

Completing the Hardware Update
% Wizard
\ The wizard has finished inztaling the zoftware for:

D ataR ay WinCamD Camera

Click Finizh ta cloze the wizard.

< Back

[Eancel |

The Device Manager should now have changed to show the installed card as follows:

_é Compuker

Elﬂ DataR.ay Beam Profilers

: ----- H& BeamMap [ Beam'R. | BeamMap-C and Beam3copeP7? Profilers
----- B8 DataRay WinCamD Camera

Shut-down and then Restart the PC. Perform 3), above.
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E. Problems II — ‘Whenever I reboot my PC, a Found New Hardware Wizard appears.’

Found MNew Hardware Wizard

Welcome to the Found New
:‘?\ Hardware Wizard

Thiz wizard helps you install software faor:

WinDrver Yirtual device

{ .'\J If your hardware came with an installation CD

.

=2 or floppy dizk. inzert it now.

What do ol want the wizard bo do?

¥ {nstall the zoftware automatically [Fecommended)

£ Install from a list or specific location [Advanced)

Click Mest to continue.

< Black I Mest » I Cancel

10) The problem is that windrvr.sys, still lurking in your PC, is causing a WinDriver Virtual Device
phantom to be detected. To prevent a recurrence on reboot proceed as follows:

Click Next>. The following screen will appear.

Check the box for Don’t prompt me again to install this software. Click Finish.

Found Mew Hardware Wizard

Cannot Install this Hardware
N\
&

The hardware wasz not installed because the wizard cannat find
the neceszary zoftware,

When thiz computer connects ta the [Rternet, Windows Update
valll search for the night goftware and notify you if it becomes
available.

jr-" Click Back if you have installation media such az a
CO-ROK, ar if pau know the location of the softmare.

Click Finizh to go to Help and Suppart Center for further
help inztalling thiz hardware.

¥ Don't prompt me again to install this software

< Back I Finizh I Cancel
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The following screen will appear. Do not choose Yes, ... or No, ... Simply click Cancel.

(D Help and Support Center x|

Get Help with Your Hardware Device

The wizard was unable to find the necessary software For wour new hardware,

Help and Support Center can now record your hardware profile o assist with Fukore support, This is done
automatically by reading the identification number that the manufacturer has encoded in vour hardware. IF wou
wank, vou can see the contents of the file that conkains this information, This information will remain confidential--
see Microsoft's privacy policy, Using this information, Microsoft can query for any available details on the hardware
manufacturer's \Web site,

O ¥es, recard my hardware profile,

i Mo, I prefer not ko participate.

This information will help us provide:

< Improved manufacturer support For new hardware inskallations in future versions of Windows,
< More supporting software For wou ko download From Microsoft Web sites,
< Links to other Internet sites that carry software or support information For wour new hardware,

Click. Cancel to end the wizard, You may wank to contact the manufacturer and ask them to provide a driver
(software) for this hardware device,

< Black I [Ext = I Cancel

If we ever have a fix for the phantom so that it never ever appears, we will release it.

F. Windows NT operation
Applies to BeamMap, BeamMap-C, BeamMap ColliMate, Beam’R only.

Does not apply to WinCamD series products — they will not operate under NT with 5.00xx
software. If you must work with NT, download the most recent 4.xx version from the website.

11) Install the DLL version of the software from the website, Version 3.XX for BeamMap, BeamMap-C,
ColliMate. Follow any instructions associated with this software at the website. Install and run the PCI
card.

12) Rename the c:\Program Files\DataRay and its desktop icon to DataRayDIl.

13) Install the iDataRay Ocx.exe version of the software. DO NOT ATTEMPT TO CHANGE THE
DRIVER THAT IT IS USING. Run the software. The system should work fine. If it does not, Contact
DataRay Technical Support.

14) See E. above for WinDriver Virtual Device issues.
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G. Running heads on prior versions of the software.

BeamMap, BeamMap-C, BeamMap ColliMate, Beam’R. Simply run the older version of the
software. The head will run just fine with the new driver.

BeamScope-P7. Never did run under versions prior to 5.00.

WinCambD series products. Simply run the older version of the software. The head will run just fine with
the new driver.
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